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Welcome to PReS® Connect, the new and highly dynamic document composition solution from 
Objectif Lune! PReS® Connect is the link between your data systems and your customer 
communications. It allows you to create fully personalised business correspondence across a range of 
output types and manage these via sophisticated and automated workflows. 
 
Key aspects of PReS® Connect include the following: 
 

 DataMapper – Extract data from multiple sources and output it in a single format 
 

 Designer – design tool for creating print, email and web communications 
 

 Output – advanced output and print stream handling across industry-standard print formats 
 

 Print Manager – for handling IPDS output 
 

 Workflow – for automating the production of output from PReS® Connect 
 
 
Installing PReS® Connect Version 1.1 and PReS® Workflow 8.1: 
 
Full details on downloading, installing and licensing PReS® Connect 1.1 and PReS® Workflow 8.1 can 
be found in the PReS® Connect Installation and Activation document.   
 
Note that both PReS® Connect 1.1 and PReS® Workflow 8.1 come with 30 day trial licenses by 
default. 
 
 
64 Bit Version Only 
 
PReS® Connect 1.1 is available as a 64 Bit version only (with the exception of the Workflow, Fax, 
Search and Imaging modules). 
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This sections provides some basic tips on getting started with PReS® Connect as well as details on 
some of the highlights of the application. 

1. Opening PReS® Connect 

 
After PReS® Connect has been installed, it can be opened via the following options in the Start menu: 
 

 
 

 Connect Designer - opens the PReS® Connect Design Tool 

 Connect Print Manager – opens the Print Manager tool for scheduling and managing IPDS 
output 

 Connect Server Configuration – opens a tool for managing job scheduling and security for 
the server as well as clean-up options 

 Connect Software Activation – opens the Software Activation tool which allows you to load a 
license file and view the terms of the End User License Agreement. 

 Release Notes – Opens the current version of the PlanetPress® Connect Release Notes 
 

Note that in the current version the user interface is only supported in English. Other languages will 
be introduced with later releases. However all languages are supported for creating documents. 
 

2. Fast Access to Information 

 
PReS® Connect includes an extensive online help system providing detailed information on most 
areas of the application. Use the “Help Topics” option in the Help menu or press F1 to access the 
home page of the help: 

 
 
Note that in Version 1.1, all calls to the online help from the application will default to the home page 
of the help. Context sensitivity will be introduced to the help system in a later release. This menu also 
provides access to the PReS ® Connect “Welcome Screen” which provides wizards and tips for setting 
up templates.  
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3. Welcome Screen for Getting Started 

 
When first starting the Connect Designer, a Welcome screen is displayed which helps you to quickly 
become acquainted with all of the key areas of PReS® Connect: 
 

 
 
The links in the “Resources”panel provide further information about PReS® Connect and Objectif 
Lune: 
 

 Knowledgebase – opens a page in the Objectif Lune knowledgebase which will eventually 
contain information on PReS® Connect. 

 Documentation – opens the PReS® Connect online help. 

 Course (OL Learn) – opens the OL Learn site where you can access any OL courses available 
to you. 

 Release Notes – opens the current release notes. 

 Newsgroup – opens a page with discussion forums around various Objectif Lune products. 

 Website – opens the Objectif Lune website. 

 Take a tour – provide an interactive tour of PReS® Connect with videos and presentations. 
 
 
Turning the Welcome Screen on and off: 
 
A “Do not show again” checkbox in the “Welcome” screen enables you to turn the screen off so that 
it no longer opens by default when starting Designer. 
 
You can call the “Welcome” screen back at any time using the Help menu or via the following button 
in the standard toolbar: 
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Template Options: 
 
The Template options in the “Welcome” screen enable you to: 
 

 Create a new Template 

 Access the available Template Wizards 

 Open an existing Template 
 
The following page is opened when selecting “Create Template”. Select an Email, Print or Web 
context for your template. Other contexts can be added later if required: 
 

 
 
 
 
Sample Templates: 
 
A selection of sample templates for previewing the functionality in PReS® Connect are available from 
the following online demo portal: 
 
http://connectdemos.ca.objectiflune.com 
 
 
 
  

http://connectdemos.ca.objectiflune.com/
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DataMapper Options: 
 
The DataMapper options in the “Welcome” screen enable you to: 
 

 Create a new DataMapping configuration 

 Open an existing DataMapping configuration 

 Open a DataMapping configuration from a “Recent” list 
 
The following options are displayed when opting to create a new DataMapping configuration. 
Clicking on a box opens settings appropriate to the selected type: 
 

 
 
 
 
 

 
 

 
 
 
 
 
 
 
  



10

 
 

 
 

 

4. Template Wizards 

 
PReS® Connect includes various easy-to-use wizards for setting up basic Email, Print, Web Page, 
Letter and Foundation Web Page templates. To access the wizards click on Template Wizards in the 
Welcome screen or go File|New to select the wizard there: 
 

 
 

 

Selecting one of the options opens a Wizard in which you can set up basic properties for that context. 
The following example shows the steps associated with setting up Banded Email and Banded Invoice 
templates. The New Banded Email Action Template wizard allows you to specify the colours of the 
bands, a logo and the subject and header text: 
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Clicking “Finish” will create the Banded Email template: 
 

 
 
 

Select the “Invoice” option in the 
“New” dialog to create a Banded 
Invoice template. This opens a 
similar dialog with additional 
settings for the payment button 
and detail table: 

 

 

 
 
 
 
 
 
 
 
 
Clicking “Finish” creates the 
Banded Invoice template: 
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5. PCL, AFP and PostScript Input for the DataMapper  

 

PCL, AFP and PostScript files can be used as input in the DataMapper. Note that PCL and AFP require 
additional features which are licensed separately. For PCL a standalone setup is available which 
installs the PCL input plugin.  
 
Both PCL and AFP input are activated in the PReS Connect license. For more information please 
contact your local OL Sales representative. 
 
Also note that the conversion of PCL, AFP and PostScript input files is carried out at Server level. This 
means that conversions of PCL, AFP and PostScript files do not work with standalone installations of 
the Designer and Server must be installed. 

 

6. The Data Model Panel 

 
The Data Model panel allows you to navigate through data records and, in the case of transactional 
sources, their individual detail records. You can navigate forwards or backwards through the 
records\details using the buttons or enter a number directly in the edit box: 
 
 

 
 
 
The Data Model pane includes 3 buttons which allow you to import, export and synchronize a model: 
 

 
 
The entries in the Data Model pane are displayed in red when synchronization is required. Press the 
button to perform the synchronization. After this the entries will be displayed in black again. 
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7. Adding and Deleting Contexts 

 
PReS® Connect allows you to add and delete a context from a template via corresponding options in 
the Resources context menu: 
 

 
 

Note that a template must contain at least one context which means that the final context cannot be 
deleted. 
 

8. Inserting Form and Structural (HTML) Elements  

 
Form and Structural elements can be inserted directly into templates via correspondingly named 
options in the “Insert” menu. The following shows the options available in the Form Elements menu: 
 

 

Buttons for Form Elements are also available in 
the toolbar: 
 

 
 
 
HMTL elements that can be inserted include: 
 

 Div 

 Span 

 Article 

 Section 

 Header 

 Footer 

 Nav 

 Aside 
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9. Pie Chart Tool 

 
PReS® Connect allows you to set up basic 3-dimensional pie charts:  
 

 

The Pie Chart tool is called via the following icon in the toolbar:  
Or via the Business Graphic option in the Insert menu: 
 

 
 
It allows you to specify static or dynamic labels and assign values for each segment: 
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10. Bar and Line Charts 

 
PReS® Connect supports the insertion of basic Bar and Line charts: 
 

  
 

The Bar and Line Chart tools are called via the following buttons in the toolbar:  
Or via the Business Graphic option in the Insert menu: 
 

 
 
They allow you to specify static or dynamic labels and assign values for each bar or line position: 
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11. Inserting Barcodes 

 
PReS® Connect includes a range of 1D and 2D barcode symbologies: 
 

 
 
Simply click on the new down arrow next to the Barcode icon in the toolbar to open up a list of 
available barcodes or go to Insert|Barcode: 
 
 

 

 
After you have selected a barcode type from the list, the Edit 
Script dialog is opened in which you can specify the value of your 
barcode.  
 
You can add one-to-many fields for the value of the code by using 
the green plus button. Each line in the table allows you to specify 
the following: 
 

 Prefix – free text field for specifying static information to 
prefix the field value 

 Field – for specifying the required field for the barcode 
value from a dropdown list 

 Format – specifies whether the value should be upper 
case or lower case. Leaving the box blank means display 
the value as specified in the data 

 Suffix – free text field for specifying static information 
after the field value 

 
 
 

 
 
 

 
Properties Dialogs for Barcodes: 
 
Each barcode type has its own properties dialog. After inserting the barcode into your template, 
right-click to open the context menu and select the properties option for the barcode. Different 
properties dialogs are displayed depending on the barcode type.  
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12.  Interaction with Capture OnTheGo  

 
PReS Connect 1.1 provides powerful functionality for introducing Capture OnTheGo (COTG) Form 
Elements to Web Contexts and sending documents to the mobile application from the Designer. 
 
To insert Capture OnTheGo Form Elements you must first create a Web Context in the Designer and 
insert a regular “Form” type Form Element. 
 
Once you have done so, right click in the Form to open the context menu. It will contain a “COTG 
Form Elements” menu from where all standard COTG elements can be inserted: 
 

 
 
Sending test documents to the mobile application: 
 
A new option is available in the File menu called “Send COTG Test” which opens the “Send COTG 
Test” wizard: 

 

 

 
 
The Store ID, Password and Recipient 
must be specified along with general 
information about the document. The 
form is sent by pressing “Finish” in the 
dialog and shortly afterwards, if the 
specified credentials are correct, it 
becomes available on the Capture 
OnTheGo app.  
 
This wizard can also be opened using 
Ctrl+F12 or the following toolbar button: 
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13. Multiple Conditions 

 
PReS® Connect supports the creation and evaluation of multiple conditions: 
 

 

 When selecting a condition, it 
is highlighted in the tree and 
its properties are shown in 
the Condition section. The 
corresponding fields related 
to this condition are also 
highlighted in the editor. 

 
 Boolean operators between 

the two conditions can be 
changed either by right-
clicking to make the popup 
appear or by double-clicking 
the operator. The value will 
then change to the next 
operator i.e., (AND -> OR -> 
XOR -> AND, etc) 

 
 When a condition is deleted, 

the orphan condition is 
paired to the last one on the 
parent level and its operator 
is deleted. 

 
 

14. Script Wizards: Simplified Conditional Content 

 
Select an element on the page, perform a right mouse click and select “Make Conditional” from the 
context menu. The Condition wizard appears allowing the user to select a data field, set the condition 
and enter/set the value to be validated. 
 
This has been implemented for the following field types: 
 

 String & HTML String 

 Boolean 

 Integer, float, currency 
 
Use the ID of the selected element or create an ID on the fly. 
 
Note that Date fields are currently not included.  
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15. Numbered and Bulleted Lists 

 
PReS® Connect supports numbered and bulleted lists via the following buttons in the toolbar: 
 

 
 
 

 
 
 

16. WYSIWYG Editor for Snippets 

 
PReS® Connect allows you to edit a Snippet in the Template window. Simply double-click on the 
Snippet in the Resources window for it to appear in the Template window where it can be edited and 
saved in either the Source or Design pane: 
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17. Tables 

 
Tables are easy to set up in PReS® Connect. Various options are available for specifying the properties 
of tables. 
 

 The Table Formatting dialog includes Height, Corner radius and Display settings as well text 
wrapping and positioning options. Other tabs allow Spacing and the Background to be 
defined: 

 
 

 The Table Cell Formatting dialog contains a Height and Width options and a Vertical Align box 
with a dropdown menu containing the alignment options: 
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 Various “Style” options are available when inserting a table including a “No Style” option: 
 

 
 
Other options for tables: 
 

 New tables can be inserted without a header row (set the value to zero) 
 

 The selection of multiple table cells is supported via both “Shift + mouse-click” and “Control + 
mouse-click” 
 

 Support is provided for numeric subtotals in tables. 
 

18. Dynamic Detail Tables 

 
PReS® Connect makes it easy to set up dynamic detail tables. It allows you to link a table to a detail 
table and subsequently define the <tr> elements that should be repeated. 
 

 A “Detail Table” option is included in the submenu for <table> elements in the context menu 
 

 The submenu shows a list of current detail tables, including an option “None” and a possible 
custom value set for the “data-detail” attribute of the table. 

 

 If the “data-detail” attribute of the <table> element is empty, None is used. If a match is 
found for the attribute, the item shows a mark next to its name. 

 

 If a "data-detail"-attribute has a value that does not exist in the list, this value is shown at the 
beginning of the list, again with a tickmark/bullet next to its name (e.g. a value that doesn't 
match any of the detail table names in the data model). 
 

 A "Repeat" option has been added to the end of the end of the submenu for <tr>elements in 
the contextual menu and in the Attributes panel for <tr> elements. This adds the "data-
repeat" attribute to the selected <tr> element.  
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19. Locale Setting 

 
A “Locale” can be specified under Edit|Locale: 
 

 
Setting the locale allows the script wizards to be based on one of the following: 
 

 The System Locale 

 An Explicit Locale – choose from a global list in the “Locale” control 

 Dependent on a database field which is then specified in the “Data field” control 
 
When the locale is based on a data field, the locale will always correspond to the current record. 
 
When the value of the locale in the field has not been specified or is erroneous (e.g., misspelled or 
mistyped), the default locale for the Java environment is used. 
 

20. Preferences 

 
PReS® Connect allows you to set up general preferences for the cleanup service, e-mailing, printing, 
scheduling and Emmet via Window|Preferences: 
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21. PreFlight Option 

 
A “Preflight” option is available from the Context menu which allows you to validate the records in 
your template against various errors. Any errors found are listed in the “Preflight” dialog along with 
the section and record in which they occurred: 
 

 
 
The “Preflight” check looks for the following: 
 

 Missing shared content e.g., missing snippets, resource file not found etc. 

 Data integrity – checks each record for workflow errors, currency errors, date errors etc. 

 Missing fields – references to missing fields in scripts 

 E-mail – common mistakes such as absolute positioned boxes, use of the transform style, 
<form> and <input> elements, background images, missing e-mail subject, invalid e-mail 
addresses etc. 

 Integrity of hyperlinks  

 Load errors 

 Missing images 

 Content overflow 

 Syntax errors 

 Custom runtime errors and warnings 

 System-generated runtime errors 
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22. Automation Using PReS® Workflow 8: 

 

 
 
If you wish to use PReS® Workflow (automation) in conjunction with PReS® Connect, you will need to 
install PReS® Workflow 8 onto the same machine.  

 
PReS® Workflow 8 can be installed in parallel on the same machine as an existing PlanetPress® Suite 
7.x installation. Note however: 
 

 If both versions need to be hosted on the same machine, PReS® Workflow 8 should always be 
installed after the legacy PlanetPress® Suite 7.x installation.  

 When uninstalling PReS® Workflow 8, you may be prompted to repair your legacy 
PlanetPress® Suite 7.x installation.  

 If PReS® Workflow 8 is installed alongside PlanetPress® Workflow 7, Capture can no longer 
be used with Workflow 7. The plugins are now registered uniquely to Workflow 8 and the 
messenger for Workflow 7 is taken offline. It is only then possible to use Capture from PReS® 
Workflow 8. 

 
For more information on installing and licensing Workflow 8, please see the Connect online help. 
 

23. Package Files for Workflow 8.1 

 
A “Package Files” option is included in the File menu which allows you to package up your Template, 
Data mapping configuration, Job Creation Preset and Output Creation Preset and send them to 
Workflow 8 for automation or to a file: 
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24. Print Wizard 

 
PReS® Connect provides a Print Wizard for easily making your output specific settings. Go File|Print 
and then select the “Advanced” button in the subsequent dialog to open the wizard: 
 

 
 
 

 Select the required “Printer Model” from the dropdown list (dependent on your license) 

 Specify the “Output Type” e.g., Windows Printer 

 Select the required “Production Options”  

 Specify the records to be produced and whether filtering and sorting should be applied 

 Specify the number of copies and whether they should be collated. 
 
The following pages of the Print Wizard will then depend on the options you have selected on the 
start page. 
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25. Data Filtering Options 

 
The Print Wizard includes various options for filtering data as shown in the following illustration: 
 

 
 
Note: when using only the Designer without the Server installed, only the “Field rule” and “Document 
Length rule” will be applicable. This is because the content sets generated from the standard Print 
Wizard are a single template/data combination. In the Server environment it is intended that users 
can merge multiple content sets in a single run and so the additional options allow filtering of specific 
content. 

It is possible however to create configurations using these rules and save them for use in the Server 
environment. 
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26. Separation Options 

 
Separation options, including page count splitting, can be specified on the following page of the Print 
Wizard:  
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27. Finishing 

 
The following Finishing options are supported in PReS® Connect: 
 

 Tray\media selection, cut & stack and n-up 

 Subset stapling of individual documents, corner stapling of both portraint and landscape 
documents; subset booklet printing and saddle stitching with fixed page count signatures  

 Mixed unstapled and subset-stapled documents 

 Subset finishing is supported in the output engine. 

 Stapling can be applied to a complete document with sub sections 

 Jogging 

 Slipsheet capabilities in the Printer Definition config 

 Finishing at document level for PCL, AFPDS and IPDS 

 Finishing at section level for PS, PCL, AFPDS, IPDS  
 

28. Finishing Options for PostScript® Printers 

 
PReS® Connect supports Finishing on a document level for any PostScript® printer: 
 

 The Finishing options are governed by a Printer Definition Configuration (PDC) file which 
must be loaded in the Advanced settings in the Print Wizard. 

 

 The PDC needs to contain all of the finishing settings available to your PostScript® printer.  
 

 The PDC provides more power and flexibility than a regular PPD in that it allows the inclusion 
of logic and conditional processing and also forms a basis for extending this power to other 
datastreams in the future. 

 

 The PDC files are created and supplied by the Objectif Lune Support Team. Please contact 
your local Support team for more information. 
 

 Some example PDC’s are provided as a reference (ol.printerdefinition).  
 
The following shows an extract from an example PDC: 
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Why is using a PDC more powerful than a PPD?  
 
Using a PDC provides more power and flexibility because it allows you to: 

 Gather information about the job as a whole (e.g., the media and finishing settings used, 
number of pages, number of documents, etc.) 

 Conditionally insert commands (e.g., only put a setpagedevice at the beginning/end of a 
sheet instead of at each logical page) 

 Define subset finishing (e.g., perform actions on document, set, segment and job boundaries) 

 Perform logically related settings in a single command (e.g., all the media-related settings are 
in a single insert, avoiding the possibility of specifying one setting but not the other) 

 A PPD only allows you to select from a list of values (which is usually a closed list) while a PDC 
allows you to insert properly encoded arbitrary values (e.g., names, colours, weights of media 
which may not be included in a PPD) 

 
 
What is the relationship between the PDC and the Finishing settings in the GUI? 
 
The PDC enables the Finishing controls in the PReS® Connect Designer GUI. It specifies which 
Finishing controls set in the GUI will be applied on production of the template. 
 
For example, if you select “Stapled” in the Designer, stapling will only be applied providing it is 
supported in the PDC. 
 
In other words, all of the Finishing options are available for selection in the GUI but they must be 
present in the associated PDC in order for them to work.  
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What about the Override Finishing options in the Print Wizard? 
 
Any “Binding” or “Hole Making” option set in the Designer which is supported by the PDC can be 
overridden by the corresponding settings in the Print Wizard: 
 

 
 

 Specify the style of binding e.g., Ring, Stapled, Glued, Stitched etc. 

 Specify the location, area and angle of the binding 

 Specify the number of holes required and the pattern.  

 Note the the “Section to edit” control is not currently supported 

 

Overriding Finishing in Multiple Sections 
 

Ignore Section level finishing and apply all finishing at a document level 

To do this, check the "Ignore section level finishing" checkbox and set the required binding and hole 
options. At print time this will apply the specified finishing options to the entire document rather 
than applying finishing at individual section levels. For example, if a template has 2 sections and 
document level stapling is applied, the pages from both sections will be combined and stapled as one 
single document. 

Override a combination of document and section finishing 

In this scenario, uncheck the "Ignore section level finishing" checkbox and use the “section to edit” 
combo box to select the required finishing settings for document and section levels. For example, if 
you had a two section template you could apply stapling on each of the sections individually and then 
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apply ring binding to the entire document. This would result in a ring bound document consisting of 
two stapled sections. 

Ignore document level finishing and override section level finishing 

In this scenario you would perform the following: 

 Uncheck the "Ignore section level finishing" checkbox 

 Select document finishing in the combo box and specify "None" for the binding style 

 Select the other sections in the combo box and apply the required finishing settings 

The result would be a document where the required binding finishing is applied to each section in the 
document but no overall binding finishing is applied to the entire document. 
 
 

29. Media Mapping for PostScript Printers  

 
PReS® Connect provides two types of mapping to PostScript printers (Media and Properties) using 
the Tray Mapping table in the Printer Settings: 
 

 
 

 The table has six columns which allow the user to specify any combination of position, 
weight, type and colour 

 At least one of the position, weight, type and colour values must be specified. e.g. the 
user could specify a weight of 80 and leave all the other fields blank  

 Setting the value for a tray on one line will cause that value to be updated on all other 
lines in the table that use the same tray name e.g., if there are two media and "tray1" is 
assigned to each of them, changing the weight on one line will also change the weight in 
the other line. This keeps the trays in sync. 

 When initialised the table will contain one row for each media and will be populated with 
as much available information from the media (e.g. specified weight, type and colour) 
although this is limited by the number of trays that are specified in the printerdef. 
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For example if the template had 3 media: 

media1: weight 80, type unspecified 
media2: type letterhead, color white 
media3: type unspecified 

and the selected printerdef had 2 trays: 

tray1: 1 
tray2: 2 

the table would appear as follows: 

 

Media Tray Position Weight Type Colour 

media1 tray1 1 80 Unspecified   

media2 tray2 2   Unspecified white 

media3 tray1 1 80 Unspecified   

 
 

30. Conditional Selection of Media 

In some cases it may be necessary to apply different media for the output depending on the value of 
a data field. The Media to be conditionally specified using scripting for the sheet positions in the 
current section:  

 The media is defined for each sheet position in the Sheet Configuration dialog. The following 
sheet positions are allowed: first, middle, last, single 

 Each Media entry in the Sheet Configuration displays a script icon. Click on the icon to invoke a 
plain script editor with a script with query selector for that specific section + sheet 

 The head element of a print section will automatically receive META elements for each sheet 

 The media can be overriden by setting the content attribute of the given META element. 

 The content attribute of the META elements will initially be empty i.e., use the media as specified 
in the Sheet Configuration dialog. 

 Media set by scripts are propagated to the Main Editor in Preview and Live mode 
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31. PDF Options and Signatures 

 
A PDF Options page in the Print Wizard allows you to make PDF-specific settings. It allows you to 
select the required PDF type (PDF, PDFA-1b, PDF-X4 and PDF-VT): 
 

 
 
It also allows you to set up PDF signatures for your output. First you must set up a Keystore and add it 
to the All Keystores table. To do so, click on the green plus icon to open the following dialog. 
 

 
 

Enter a unique name for the keystore and 
browse to the required .pfx Personal 
Information Exchange file. 
 
You must then specify the required 
Keystore Type (JKS, PKCS11 or PKCS12).  
 
The Provider is set to SUN by default. Note 
that this entry will sometimes fail in 
Version 1.0.1 and should be left blank. This 
is a known issue and will be addressed in a 
later release. 
 
You must then enter the password 
associated with your certificate and then 
browse to the required Properties File i.e., 
security certificate (format = .cer).  

When you have finished making your settings, click OK to add the Keystore to the table (note that if a 
Keystore is assigned to a signature, it cannot be deleted from the list): 
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You must then specify the actual PDF signature to be used in the template. Click on the green plus 
icon next to the All Signatures box to open the PDF Signature dialog: 

 
 

 

 Provide a unique name for the 
signature and select the Keystore on 
which it should be based. 

 

 Provide details about the reason for 
the signature and the contact person 
(can be left blank). 

 

 Provide the password for the 
specified Keystore (same password 
as the previous dialog) plus any Alias. 

 

 Set up timestamping if this is 
required, e.g., if you wish to use 
VeriSign (the Handler setting must 
be VeriSign PPKVS or Adobe PPKMS).  

 

 Specify whether or not the signature 
should be visible in a designated area 
in the document. 
 

 Click OK when you have finished 
making your settings to add the 
signature to the All Signatures box. 

 
Any number of signatures can be set up for the template providing that each is based on one of the 
specified Keystores. When you now produce your template to PDF, the signature you have set up will 
be assigned to your template: 
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32. Inserter Options and OMR Settings 

 
The Inserter options and OMR settings are provided on dedicated pages of the Print Wizard: 
 

 
 
 

 Specify the required inserter machine in the “Model” box 
 

 Select the OMR type and Fold type in the “Options” box, including whether the OMR should 
be printed on the front or the back. 
 

 Specify any selective inserts 
 

 Specify a white background for the OMR and its margins 
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33. Print Manager for IPDS 

 

 
 
PReS® Connect includes a Print Manager tool to enable operators in a print room environment to 
print and manage IPDS files generated by Connect. It is installed by selecting the “Print Manager” 
option in the PReS® Connect setup. 
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The general workflow is as follows: 
 

 Print Manager can be installed as both a standalone application or in conjunction with the 
PReS® Connect Designer and/or Server. After installation, an entry will appear in the Start 
menu which allows you to open the Print Manager 

 

 
 

 The operator sets up a list of available printers in the Print Manager and specifies their 
properties e.g., IP address, port number etc. 

 

 Three hot folders can be set up for each printer (high priority, medium priority or low 
priority). 

 

 PReS Workflow directs the IPDS files generated by PReS® Connect to one of the hot folders 
for the designated printer, or to a generic printer queue not associated with any specific 
printer. 

 

 When producing to the hot folders, jobs are processed immediately in order of priority. Jobs 
in the High priority folder are processed first, then Medium priority, then Low priority. 

 

 The operator monitors the jobs sent to the generic printer queue and drags them to a 
priority queue on the required printer  
 

 The operator can also drag jobs directly from Windows Explorer to the required printer. 
 

 The operator can pause and start a printer and specify a page range for a job. 

 
Full documentation on Print Manager can be found in the PReS® Connect online help. 
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1. What are Performance Packs? 

 
Performance Packs allow you to increase the output speed of PReS Connect. Each Performance Pack 
allows one Connect Server Extension to be installed on a different machine. The Master Server then 
automatically balances the output creation across the available Server Extension machines. This 
system of Master Servers plus Extensions is generically known as “Clustering”. 
 
For more information on purchasing Performance Packs, please contact your local Objectif Lune 
Sales Office. 
 

2. How are Clustered Environments Set Up? 

The following is a summary of the steps required to set up a clustered environment. More detailed 
information is provided in the PReS Connect online help. There are 6 basic steps:  

1. You must first set up the Master Server – this will usually be the same machine that hosts the 
MySQL Database. This is done using the “Connect Server” and “MySQL” options in the setup. 

2. You then have to configure the MySQL Database to allow access to it from other machines in 
the cluster. 

3. You then set up the Server Extensions on the required slave machines. This is done using the 
“Connect Server Extension” option in the setup. The installer needs to be run on each 
machine on which the Server Extension should be installed. 

4. Once you have completed steps 1 to 3, the magic numbers need to be submitted to Objectif 
Lune for the creation of the PReS Connect license. 

5. The “Server Extension Configuration Tool” installed with each Server Extension then allows 
you to set up the connection between the Extension and the Master Server. 

6. Finally you must configure the number of local and remote engines for each machine in the 
cluster. 

3. Licenses in Clustered Environments 

A PReS Connect license can be associated with more than one magic number. So in a clustered 
environment the same license is loaded onto each machine in the cluster. It is only necessary to 
provide the magic numbers to Objectif Lune of all the machines in the cluster and identify which is 
associated with the Master Server and which ones the Extensions. A single license will then be issued 
which can be loaded onto all machines. 

4. AFP and PCL Input in Clustered Environments 

PReS Connect allows you to purchase additional modules for converting PCL and AFP files to PDF 
format for DataMapping. Separate license activations are required for each module. Where one of 
these modules is hosted in a clustered environment, each machine in the cluster must be licensed for 
that module.  
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1. GoDaddy Certificates 

 
When installing Connect offline, dialogs are available in the setup for installing the GoDaddy 
certificates. Most users will leave the default settings and click “Next”. In some cases however 
this may not work correctly. For this reason users should activate “Place all certificates in the 
following store” and then select the “Trusted Root Certification Authorities” as the target 
certificate store. 
 

2. Server Restart 

 
After installing Connect, a Server restart can sometimes be initiated during the license activation 
which can lock the database and break Connect. In the background it has set a flag in the 
database that cannot be cleared. In order to fix the problem you need to reinstall Connect or 
stop the MySQL table. This issue will be fixed in a later release. 
 

3. Upgrading a Standalone Installation of Designer 

 
If you have installed an earlier release candidate version of the Connect Designer as a 
standalone, the merge and Weaver engines will not start correctly after upgrading to version 1.1.  
 
To fix this problem you need to delete the HSQLDB in the following folder: 
 
C:\Users\{current user}\AppData\Local\Temp\connect.database\ 
 
This database will be reinitialized automatically on the next start-up. The problem will be fixed in 
a later release of Connect. 
 

4. PostScript Print Presets 

 
The print presets for PostScript have been changed in Version 1.1 meaning that some presets 
created in Version 1.0 or 1.0.1 may no longer work. 
 
Any PostScript print preset from Version 1.0 that contains the following will not work in Version 
1.1: *.all[0].* 
 
Any preset containing this code will need to be recreated in Version 1.1. 
 

5. Available Print Presets 

 
Note that if you are upgrading from an earlier version of Connect, only one Printer Model will 
appear on the Advanced page of the Print Wizard (Generic PDF by default). From 1.1 onwards 
you need to go to “Window|Preferences|Print|Available Printers” and specify which presets you 
wish to be available on the Advanced page of the Print Wizard.  
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Note that the descriptions of some of the printers have been updated in version 1.1 meaning that 
if you had an earlier version installed, you may find that the same printer appears twice in the list 
with slightly different descriptions.  
 
For example the following default settings are identical: 
 

 Generic PS LEVEL2 (DSC compliant) 

 Generic PS LEVEL2 (DSC) 
 
 

6. Stability in Clustered Environments 

 
In some circumstances a clustered PReS Connect 1.1 environment may stop producing output 
after a certain period of time and will need to be restarted. This is a known issue and a fix will be 
provided in a forthcoming release to address the issue.  

 

7. External Resources in Connect 

 
There are certain limitations on how external resources can be used in Connect. For example if 
you want to link a file (e.g., CSS, image, JavaScript etc.) from a location on the network but you 
do not want to have a copy of the file saved with the template you need to do the following: 

 
1. The resource must be located where it can be accessed by all Servers/Slaves run as users. 

Failure to do this will cause the image to appear as a Red X in the output for all documents 
which were merged by engines which could not access the file. The job will terminate 
normally and the error will be logged. 

 
2. The file must be referenced via a UNC path e.g., 

 
file:////w2k8r2envan/z%20images/Picture/Supported/JPG/AB004763.jpg 
 

a. UNC paths are required because the services will be unable to access mapped 
network drives (Windows security feature). 

b. The engine processing the job will look on the local file system for the direct file path 
leading to the “resource not found” issue mentioned above. 
 

Important Note: The Designer itself and Proof Print do not use processes that run as services and 
they may find local files with non-UNC paths which can lead to the false impression that the 
resources are correct. 
 
 
 
 
 
 
 
 
 
 

file://w2k8r2envan/z%20images/Picture/Supported/JPG/AB004763.jpg
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8. Image Preview in Designer 

If in the Windows Internet settings (Connection Settings -> LAN configuration) a proxy is enabled, 
but "Bypass proxy settings for local addresses" is not checked, the image preview service, 
conversion service and live preview tab in the Designer will not work and exhibit the following 
issues: 

 Images will be shows as 0 size boxes (no red 'X' is displayed) 

 Live preview does not progress, and when re-activated reports "browsers is busy" 

To fix the issue you must check the "Bypass proxy settings for local addresses" option. 
 

9. Using Capture After Installing Workflow 8 

If PReS Workflow 8 has been installed alongside PlanetPress® Workflow 7, Capture can no longer 
be used with Workflow 7. The plugins are now registered uniquely to Workflow 8 and the 
messenger for Workflow 7 is taken offline. It is only then possible to use Capture from PReS 
Workflow 8. 
 

10. Capturing Spool Files After Installing Workflow 8 

If PReS Workflow 8 has been installed alongside PlanetPress® Workflow 7, PlanetPress Designer's 
option to capture spool files from printer queues is no longer functional. The solution is to use 
Workflow 8.x to capture spool files from printer queues. 
 

11. Colour Model in Stylesheets 

In Version 1.1 the colour model of colours defined in a stylesheet can sometimes change after 
editing the stylesheet. This is a known issue and will be addressed in a subsequent release.  
 

12. Business Graphics in Email Output 

Business graphics (pie charts, bar charts etc) are not always appearing in output. This will be fixed 
in a subsequent release. 
 

13. Online Help Links Point to Introductory Page 

Context sensitivity for the online help is disabled in PReS Connect Version 1.1 meaning that all 
links and F1 calls currently point to the introductory page of the help. Context sensitivity will be 
re-introduced in a subsequent release of PReS Connect. 
 

14. Legal Notices and Acknowledgements in the Connect About box 

In PReS Connect Version 1.1, the link to the “Legal Notices and Acknowledgements” in the About 
box currently points to the introductory page of the online help. To read the legal notices you 
must navigate through the online help using either the contents tree or a search. This will be 
addressed in a subsequent release of Connect. 
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15. Job does not Cancel on Error 

The Designer can sometimes appear to hang when encountering an error. If you then attempt to 
abort the job, the job does not cancel. 
 

16. Black Screen sometimes appearing in the Designer 

The Designer window can sometimes turn black after opening and closing multiple templates. 
This is a known issue and will be addressed in a later release. 
 

17. Registration of PReS Plugin for Watch 

In the current version of PReS (6.3.0) the DLL for the PReS Plugin for Watch has to be installed 
and registered manually. This will be automated with the release of PReS 6.3.1. 
 

18. PDF Output sometimes produces random error 

When running PDF output multiple times, an “Object XX is not defined” error can sometimes 
occur. This problem only occurs on Windows 8.1 and will be fixed in a later release. 
 

19. Dragging and Dropping a Step into a Condition 

Dragging and dropping a step into a condition or repeat step can sometimes delete the step. This 
will be addressed in a later release. 
 

20. Encoding 

Issues may sometimes be encountered in menus and templates when running PReS Connect on a 
non-English operating system. These are due to encoding issues and will be addressed in a later 
release. 
 

21. Templates and Data Mapping Configurations from earlier Betas and Release Candidates 
 

Please note that templates and data mapping configurations created in earlier Betas and Release 
Candidate versions may not open or function correctly in Version 1.1.  

 

22. Merge\Weaver Engines when Printing 
 

The print operation in the Designer will automatically detect whether the Merge\Weaver 
engines are available and display a message for the user to retry or cancel if not. Once the 
Merge\Weaver engine becomes available and the user presses retry the print operation will 
proceed as normal. This message can also occur in the following circumstances: 
 

 If the server is offline and you are not using Proof Print 

 On some occasions before the Print Wizard opens 
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23. REST Calls for Remote Services 
 

The Server will now accept REST calls for all remote services and will make commands wait 
indefinitely until the required engines become available. The Server will log when it is waiting for 
an engine and when it becomes available. Note that there is no way to cancel any commands 
other than stopping the Server.  

 

24. Print Content and Email Content in PReS Workflow 
 

In PReS Workflow’s Print Content and Email Content tasks, the option to Update Records from 
Metadata will only work for fields whose data type is set to String in the data model. Fields of 
other types will not be updated in the database and no error will be raised. This will be fixed in a 
later release of PReS Connect. 
 

25. VIPP Output 
 

Some templates set up with landscape orientation are being produced as portrait in VIPP. It can 
also sometimes be the case that text and images can be slightly displaced. These are known 
issues and will be addressed in a later release of PReS Connect. 
 

26. Print Limitations when the Output Server is located on a different machine 

The following limitation may occur when using the Print options from a Designer located on a 
different machine to the Output Server: 

 The file path for the prompt and directory output modes is evaluated on both the client AND 
server side. When printing to a network share it must be available to BOTH the Designer and 
Server for the job to terminate successfully. 

 The Windows printer must be installed on both the Server and Designer machines. 

 When printing via the Server from a remote Designer, the output file remains on the Server 
machine. 

 


